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The Ribbon is Your Friend.  No, really. 
 

TOOL NO. 1:  THE GOVERNING BODY OF WORKSPACES 
 

Workspace definition (per the Help menu):  Workspaces are sets of menus, toolbars, palettes, and ribbon control panels 

that are grouped and organized so that you can work in a custom, task-oriented drawing environment. 
 

MEMO:  At the office, if you have already ‘arranged’ your Ribbon (or are still using Toolbars), I would recommend 

that you first create a workspace of your current arrangement so you can return to that condition when you’re 

finished ‘experimenting’. 
 

How to Create a Workspace 
 

1..  To save your current workspace by name, click the Workspace Switching icon on the 

right half of the status bar, then click Save Current As. 
 

2..  Enter a name for the current workspace, then click Save. 
 

Once you learn more about the Ribbon, you can come back and update your Workspace. 
 

TOOL NO. 2:  HOT SPOTS ON THE RIBBON 
 

Ribbon Terms 
Heidi Hewitt, AutoCAD Technical Marketing Manager, has a wonderfully succinct phrase to define the Ribbon: 
 

“Each tab contains multiple panels, and each panel contains multiple tools.” 

Tabs 

By default, there are eight tabs in the 2D Workspace of AutoCAD 2010 and AutoCAD 2011. 
 

Panels  

The panels are the large parts of the Ribbon.  Draw panel of the Home tab shown here. Panel titles 

with black triangle beside the name can be expanded to display more tools.   
 

Tools 

The Tools are the commands on the panels.  Tools with black triangles have more tools. 
 

Ideas for Personalizing the Ribbon 

You will want to personalize the Ribbon to get rid of the stuff that doesn’t apply to your daily activities, and optimize the 

buttons to be the most effective.  
 

The Minimize arrow 

In AutoCAD 2011, there are four settings to the Minimize arrow:  The full Ribbon, Minimize to Tabs, Minimize to Panel 

Titles, and Minimize to Panel Buttons. 
 

The Shortcut Menus 

Right-click anywhere on the Ribbon for a shortcut menu with Tabs and Panels.  The list of panels is based on the current 

Tab. 

How to Update Your Workspace with the Changes 
 

1..  After making the desired changes to your workspace, click Workspace Switching, then click Save Current As. 
 

2..  In the drop-down list, choose the name of the workspace for the changes, then click Save. 
 

3..  When you see the notice regarding replacing the workspace that already exists, click Replace. 



www.autocadtrainerguy.com 

2 

TOOL NO. 3:  FIND ANY TEXT ANYWHERE 
 

How many hours have you spent looking for room numbers, people, phone numbers, etc. in a drawing you’re not 

familiar with?! 
 

Solution:  Annotate tab >Text tab >Find Text field 
 

How to Find Any Text on Any Drawing 
 

1..  On the Annotate tab >Text panel, in the ‘Find text’ field, enter the text to find, then press [Enter]. 
 

AutoCAD automatically zooms to the first instance of the requested text and the Find and Replace dialog box appears 

(shown here for the word ‘VACANT’). 
 

Insights 
The Find and Replace dialog box has some other useful features such as the More Options button and the List Results 

check box. 
 

MEMO:  If you have the List Results box checked, it doesn’t kick in the ‘Zoom To’ feature. 
 

More Options 

Click this peek-a-boo button (technical term) to display a list of Search Options and Text 

Types.  By default, Search Xrefs is not checked, but I would recommend that 

you check this box. 

 

TOOL 4:  QUICK DISTANCES AND AREAS 
 

On the Home tab >Utilities panel is a more elegant command for Distance, as well as an Area feature that is more 

dynamic.  Click Measure to display the assortment of measuring features in the Measuregeom command. 
 

Distance 

Click Distance and the DYN feature is automatically toggled on.  After picking the first point,    type M to launch the 

Multiple points option.  As you continue to click points, the command line displays a running total for the ‘Distance’. 
 

Area 

Use Area to pick points around the perimeter of the space and a dynamic solid hatch is displayed as you pick each point. 
 

How to Use the Area Feature from Measure 
 

1..  Click Area [Home tab >Utilities panel >Measure dropdown].  The Dynamic Input feature will automatically be toggled 

on and you will be prompted to specify the first point. 
 

2..  After picking the last point, right-click to display the Area and Perimeter information of the space enclosed by the 

pick points (shown here). 
 

3..  Hit Esc or type X to end the command.  (The colored area is just temporary.) 
 

TOOL 5:  CUSTOMIZE THE QUICK ACCESS TOOLBAR 
 

When using the Ribbon, you’ll be giving up your toolbars.  But if you have a few favorites, the 

Quick Access Toolbar is the way to go. 
 

How to Add Commands to the Quick Access Toolbar 
 

1..  Find a favorite tool on the Ribbon – Layer Lock (expanded Layers panel), Layer Freeze, 

Measure, etc. 
 

2..  Right-click on that tool, then click Add to Quick Access Toolbar.  That’s it! 
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How to Arrange the Quick Access Toolbar Tools 
 

1..  Save your current workspace, then type CUI to open the Customize User Interface. 
 

2..  Expand the Quick Access Toolbars node, then expand Quick Access Toolbar 1 to display the content for your Quick 

Access Toolbar. 
 

3..  Pick and drag the tools to the desired location, then click OK to close the CUI and save your changes. 
 

MEMO:  The Quick Access Toolbar, by default, is independent of your workspace.  This means as you change 

workspaces, the Quick Access Toolbar remains constant.  There is coverage on assigning a Quick Access Toolbar to a 

workspace in the Customizing chapter of The AutoCAD Workbench. 

 

TOOL 6:  ATTACH AND DRAW ON A .PDF UNDERLAY 
 

Beginning in AutoCAD 2010, you can accurately scale a .PDF to be 1:1.  If the PDF was created from an AutoCAD drawing, 

you can also turn off the layers. 
 

The PDF Underlay [Insert tab >Reference panel >Attach] is attached the same way you would attach an Xref. 
 

Be Nice. 

When using the Relative Path setting for the Path Type, you must have a valid drawing name before you attach the .PDF 

underlay.  By attaching the .PDF using Relative Path, AutoCAD will look in the host’s path to find the .PDF when the 

host is opened. 
 

How to Attach and Scale the .PDF Underlay 
 

1..  Begin a new drawing, then save it. 
 

2..  Click Attach [ Insert tab >Reference panel] to open the Select Reference File dialog box. 
 

3..  At the bottom, change the Files of Type to PDF Files (*.pdf). 
 

4..  Navigate to the .PDF you want, then click Open to 

open the Attach PDF Underlay dialog box. 
 

5..  Per the above memo, set the Path Type to Relative 

Path.  The next time you attach  a. PDF, Relative 

Path will be the default. 
 

6..  To attach the .PDF at 0,0,0, clear the check box for 

the ‘Insertion Point’ for Specify On-Screen. 
 

7..  Click OK, then Zoom >Extents if needed. 

 
  

MEMO:  You can also use the External References window to attach a .PDF Underlay by selecting Attach PDF from 

the dropdown list.  Since a .PDF is considered an externally referenced file, all Xref-related procedures apply.  
 

 

Scaling the .PDF to Make It 1:1 

There’s not a .PDF on the planet that’s 1:1, so here’s how to use the Scale command to make it full scale. 
 

How to Scale a PDF Underlay to 1:1 
 

1..  Click Scale [Home tab >Modify panel]. 
 

2..  Select any part of the geometry on the .PDF, then press [Enter]. 
 

MEMO:  Although the .PDF geometry does not highlight after you click on it like other objects in your drawing, you 

will notice ‘1 found’ on the command line, confirming your selection.  
 

3..  When prompted for the base point, enter 0,0.  
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4..  When prompted to specify a scale factor, enter R for the Reference option. 
 

5..  For the reference length, zoom up to a location where you know the distance between two identifiable points, such 

as a door opening.  
 

6..  Accurately (i.e., using an object snap) pick two points that specify the distance you want to scale.  In this case, the 

two sides of a 3’-0” door opening. 
 

7..  When prompted for the new length, enter the true distance between those two points.   
 

TOOL NO. 7:  PUSHBUTTON MTEXT 
 

And finally, a new button for your palette to automate the placement of Mtext! 
 

The key player in this scenario is the variable TEXTSIZE.  If we can automate the setting of 

that variable before launching the Mtext command, we’re good to go! 
  

How to Automate Mtext on the Tool Palette 
  

1..  Open a drawing containing Mtext in Model space that is on a layer you typically use and in the desired text style.  Or 

you could just add some Mtext to a new drawing if you set your layer and text style first. 
  

2..  Open the Tool Palette window [View tab >Palettes panel or Ctrl + 3 ], then set your favorite tab to be current. 
  

3..  Select the Mtext in the drawing, breathe, then drag the Mtext over and drop it onto your palette. 
  

4..  Right-click on the Mtext button on the palette, then click Properties. 
  

5..  Change the Name for this tool; I’m going with Mtext @ 9”. 
  

6..  If you want the text in Model space to be 9” high, change the Command String to read as follows: 
  

^C^CTEXTSIZE;9;MTEXT; 

Text Character Reference 
  

^C^C  Hit Esc to cancel the current command 
 

TEXTSIZE     System variable that stores the text height the next time you use a text command 
 

;         Press [Enter] 
 

9        The desired height of the text 
 

Mtext Launches the Mtext command 
 

7..  Under General, confirm the standard properties, as well as the Text style. 
  

8..  Click OK to save your changes and close the Tool Properties dialog box. 
  

Standard testing procedures apply.  Open any other drawing that doesn’t have those layer and text style settings, go to 

Model space and test it out! 
 

FREE ADDITIONAL RESOURCES 
 

Get downloads at my website, www.autocadtrainerguy.com. Click on the “AutoCAD Stuff” link, 

then read the instructions. 
  

 

What The .LSP Files Do 
 

ATTSTRIP.VLX - Fabulous feature strips the attributes of the selected attributed blocks, but retains the integrity of the 

block itself.  This is great if you have to provide a drawing to the customer or an architect and would rather not pass 

along the product information.  The .VLX extension means it is a compiled Lisp routine that was created using Visual Lisp 

and should be treated the exact same way as a .LSP.  [Original .LSP found at www.dotsoft.com]. 
 

DLINE:  Parallel line generator.  [See Michael’s Corner - August 2003 & September 2005] 
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GLUE:  Joins two lines into a single line.  Ideal for mending walls after deleting a door or a wall. The JOIN command in 

AutoCAD requires that the lines being joined be exactly co-linear, the Glue routine does not. 
 

OBJNO:  Simple numbering. 
 

PREFIX:  Prefix adjacent to the number. 
 

WSNUM:  Prefix “With Space” before the number. 
 

Dynamic Blocks + Michael’s Sample Template 
 

DynaDoor.dwg - This dynamic door block is created with five sizes - 24", 30", 36", 42", & 48" - and 

also has a flip parameter.  
 

DynaLabel.dwg - This dynamic label block is intended for use in Paper space; 

the line can be stretched to accommodate the length of the text.   
  

DynaPower.dwg - This dynamic block has three visibility parameters:  Duplex receptacle, DataComm, 

and Single pole light switch.  This block also has an alignment parameter at the insertion point which 

causes the block to align to the line where it’s placed. 
 

 

NOTE Regarding the ‘Dyna-‘ drawings:  After unzipping the file, open Dyna-.DWG (don't Insert it).  If you want to put it 

on a palette, open your block source file, then drag the Dyna- block into your block source.  Save your block source 

drawing, then drag the Dyna- block onto your palette. 
 

ATGTemplate.dwt -  This is my template in case you don't have one and didn't want to start from scratch.  Put this in 

AutoCAD's ..\Template folder (you will need to make one for A2009, A2010, and A2011). See Michael's Corner from 

February 2004 on how to set your system up to use this .DWT.   

 

AVAILABLE TRAINING SEMINARS 
 

 

AutoCAD® Trainer Guy Seminars… 

� AutoCAD 2011 Update - 1-day 

� AutoCAD 2010 Update - 1-day 

� AutoCAD Intermediate   [customized] 

� AutoCAD Advanced   [customized] 

� CAP Studio - 2-day 

 CAP Designer  [can be presented individually - 1-day] 

 CAP Worksheet  [can be presented individually - 1-day] 
 

Summaries for the above seminars can be found on the Training Topics link on my website. 
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T h e  m i n d  o f  m a n  p l a n s  h i s  w a y ,  b u t  t h e  L o r d  d i r e c t s  h i s  s t e p s .  
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